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1 Checking the Postscript Kit Contents

The devices and components of the kit are described below.

If any of the following are missing, contact the Xerox Welcome Center.

0 )

:CICICI

Lo |

Postscript Program ROM

This ROM makes postscript printing
possible with the printer.

1 postscript Driver Library CD-ROM

Includes the postscript drivers and screen
fonts.

License Agreement

Adobe PostScript 3
postscript Logo Seal

This seal accompanies printers
compatible with postscript.

Xerox WorkCentre/WorkCentre Pro 123/128 Postscript® User Guide




1 Checking the Postscript Kit Contents
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2 Operation with Windows 95/98/Me

The following information can be found in this chapter:
¢ About the Software
— Bundled Software
— Hardware/Software Requirements
 Installing the AdobePS Printer Driver
— Installation Procedure
¢ Printer Driver Properties
— Configuration Tab Settings
— Options Tab Settings
— Output Settings Tab Settings
« How to Use Help

About the Software

This section describes the software for Windows 95, Windows 98, and Windows Me included
on the Postscript Driver Library CD-ROM.

Bundled Software

The following items are included on the enclosed CD-ROM.

AdobePS Printer Driver (ver.4.5.3) and PPD files - Adobe Postscript driver and PPD files (for
Windows 95/98/Me).

ATM (Adobe Type Manager)(ver.4.0) - Helps you to install typefaces and activate and manage
your fonts.

Adobe Screen Fonts (TrueType/Postscript) - Includes 136 screen fonts (19 TrueType fonts
and 117 Postscript fonts), which are compatible with the printer fonts. ATM is used to install the
Postscript screen fonts. When using these fonts to print, it is recommended that you use the
Adobe Postscript (4.5.3) printer driver.

Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing
platforms.

Xerox WorkCentre/WorkCentre Pro 123/128 Postscript® User Guide 9



2 Operation with Windows 95/98/Me

Hardware/Software Requirements

The minimum system requirements for the Windows 95/Windows 98/Windows Me printer driver
are described below.

Computer System

Personal computer in which the Windows 95/Windows 98/Windows Me OS can operate.

Basic Software

Windows 95, Windows 98 or Windows Me

Installing the AdobePS Printer Driver

Install AdobePS 4.5.3 printer driver onto Windows 95, Windows 98 or Windows Me by following
the procedure below.

This section describes how to install the printer driver for Windows 98, as an example.

It is possible to cancel installation of the printer driver by clicking [Cancel] in the dialog box
displayed during installation. You can also click [Back] to ignore the settings in that dialog box
and return to the previous dialog box.

Installation Procedure

Start Windows 98.

On the Start menu, point to Settings and click [Printers].
In the Printers window, double-click [Add Printer].

Click [Next].

Select how the printer is connected to the computer and click [Next].
Select [Local printer] when the printer is connected directly to the computer.
Otherwise, select [Network printer]. The following is an example of a local printer.

ok bR

NOTE: When you select [Network printer], specify the path to the printer in the
network path or queue name box.

6. Insert the Postscript Driver Library CD-ROM in your CD-ROM drive.

7. Click [Have Disk].

8. Enter “Drive Name:\English\PrinterDriver\win9x_Me” in the “Copy manufacturer’s
files from.” box and click [OK].
In this guide, we have used “E:” as the CD-ROM drive. If you are using a different
drive for the CD-ROM, specify accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM.

9. Select your printer model from the Printers list and click [Next].

10. Select the port that you are using and click [Next].

10
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2 Operation with Windows 95/98/Me

11. Type a name for the printer and specify whether you want to use the printer as the
default printer, then click [Next].

12. Specify whether or not to print a test page, then click [Finish].
Installation begins.
13. Read the End User License Agreement and click [Agree].

If you click [Disagree], see If you click Disagree in the License Agreement on
page 11 for details.

14. Confirm that a printer has been added in the Printers window.

This completes installation of the printer driver. Remove the CD-ROM from the
drive.

See Printer Driver Properties on page 11 to configure the printer.
Store your CD-ROM in a safe place.

If you click Disagree in the License Agreement

Click [No] to return to the operation and continue.

Click [Yes] to cancel the installation. A printer is added to the Printers window, but the printer
driver is not installed properly.

When you right-click the printer and click [Properties] from the menu, the Re-installation tab is
added to the printer driver properties dialog box. Follow the directions on that tab.

When you finish reinstalling the printer driver, see Printer Driver Properties on page 11 to set up
the printer.

Printer Driver Properties

This section describes printer specific settings included in the printer driver properties.
e Configuration Tab

e Options Tab

e Output Settings Tab

NOTE: You can also refer to Help for explanations of these settings. See How to Use
Help on page 16 for details about how to use Help.

To view the printer driver properties, select the printer icon in the Printers window, then click
[Properties] on the File menu.
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2 Operation with Windows 95/98/Me

Configuration Tab Settings

Settings

This section describes the settings of the Configuration tab.

Select the function that you want to set in the Features List and change the settings in the
Change box below.

21

General Detailz | Faper | Graphics | Fontz | PuostScnpt

‘wWatermarks Canfiguration | Options | Output Settings
Features List

Image Enhancement -

Draft Made O =

Fritt Mode Standard

Stapling Mare

Bypazz Feed Orientation Partrait

Offzet Stacking Mare

Feed Separators fram Mare

Print on Separators Blank Separators

Paper Type [Separators) Uze Printer Settings

Callated O

Halftane Fire Dots

Custarn Paper Auto Orientation On

Substitute Trap Uze Printer Settings 1.

Print Mixed Size Originalz O

Available Printer b emorny 15432 KB

&eailable Frnt Carkhe FIRR KR LI
Settings for: Image Enhancement

On j
Help | Restore Defaults |
QK | Cancel | Lpply |

NOTE: You can restore defaults by clicking [Restore Defaults].

NOTE: The settings that can be selected vary depending on which options have been
installed. Change these settings only after confirming that the option settings are
complete. See Options Tab Settings on page 14.

Image Enhancement - Specifies whether or not to use the Image Enhancement function.

Selecting [On] smooths out boundaries when printing. This reduces jagged edges by artificially
increasing the resolution of the image. When printing a bitmapped image composed of coarse
halftone dots, smooth color gradation is impossible in certain situations. In this case, select [Off].

Draft Mode - Specifies whether or not to reduce the amount of toner used when printing drafts.
When [On] is selected, the overall printed color becomes lighter. This is best for printing
documents when high print quality is not necessary.

Print Mode - Specifies whether to give priority to the print speed or the image quality.

Stapling - Specifies whether or not to staple printed documents and the position of the staple.
You can staple 2 to 50 sheets of 80 g/m? or lighter paper.

12
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2 Operation with Windows 95/98/Me

NOTE: You cannot use staples in the following situations.

— When anything other than Finisher Tray is selected for Output Destination in the
Advanced tab.

— When Job Offset is selected.

Bypass Feed Orientation - Specifies the paper orientation when printing from the bypass tray.
When feeding the short edge of the paper first, select [Landscape]. When feeding the long edge
of the paper, select [Portrait].

Offset Stacking - The position of individual jobs or sets of copies are shifted to either side of
the output tray to enable easy separation.

Feed Separators from - Specifies the paper tray that transparency dividers are to be fed from.
When [Auto] is selected, the tray set on the machine is used as the feed destination.

Print on Separators - Specifies whether or not to print on the transparency dividers as well as
the transparency.

Paper Type (Separators) - Specifies a paper type for the transparency divider.
Collated - Selects whether to collate a multiple-page file per set when they are printed.
Halftone - Select the halftone settings for printing.

Select [Fine Dots] for the small size halftone dot commonly used in Postscript.

Select [Thick Dots] for coarser dots than the Fine Dots setting.

Select [Type 3] for the same halftone setting that is used in PCL.

Custom Paper Auto Orientation - Specifies whether or not to correct the orientation of the
custom paper.

Substitute Tray - Specifies what action to take when the paper for the print size is not loaded
in the machine.

Use Printer Settings - Use the printer settings. The settings can be confirmed on
the control panel.

Display Message - Display paper supply messages on the control panel. Printing
is impossible until paper is supplied.

Use Nearest Size (Adjust to Fit) - Selects the nearest paper size and automatically
adjusts the image size as necessary.

Use Nearest Size (No Zoom) - Selects the nearest paper size and prints the same
size as the image.

Use Larger Size (Adjust to Fit) - Selects paper larger than the original and
automatically adjusts the image size as necessary.

Use Larger Size (No Zoom) - Selects paper larger than the original and prints the
same size as the image.

Feed from Bypass Tray - Feed from bypass tray.
Print Mixed Size Originals - Controls the orientation of the second-side image when printing
double-sided.

Available Printer Memory - Enter the amount of usable printer memory (in KB) in the Edit box.
Usually, it is not necessary to change this.

Available Font Cache - Enter the amount of memory available for the font cache (in KB) in the
Edit box. Usually, it is not necessary to change this.

Account Mode - Specifies if all users or only System Administrators can change authentication
related settings.
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2 Operation with Windows 95/98/Me

Options Tab Settings

This section describes the settings in the Options tab.

Select the items in Hardware Options and change them in the Change box below. To use this
function, it is necessary to make appropriate settings in this tab.

Xerox WorkCentre M128 PS5 2 x|
General I Detailz I Faper I Graphics | Fontz | PuostScnpt
‘wWatermarks | Configuration Options | Output Settings

Hardware Options

[ ot Available
Tray Dptions Mt Awailable
Firizher Mot Awvailable
Fiegional Paper Setting AB Series
Switch Paper Size [8KA16E) Simplified Chinese
Mermam Standard 256MB
Settings for: Hard Disk

Mot Available |

Get Information fram Printer |

Help | Restore Default |

QK | Cancel | Spply |

NOTE: You can restore defaults by clicking [Restore Default].

Settings
Hard Disk - Specifies whether or not the Hard Disk (optional) is installed. If it is, set to
[Available].
Tray Options - Specifies the paper tray type installed on the machine.
When [2-Tray Unit] is selected, Tray 3 and Tray 4 can be used.
When [2-Tray Unit (High Capacity)] is selected, Tray 3 and Tray 4 can be used as the high
capacity feeder.
Finisher - Specifies if the Finisher (optional) is installed. If it is, set to [Available].
Paper Size Setting - Specifies the paper size group for different areas to enable the selection
of paper size common to that location.
Switch Paper Size (8K/16K) - Indicate your language preference to enable the set of 8K and
16K paper size that is best suited to your needs.
Memory - Specify the amount of printer memory.
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2 Operation with Windows 95/98/Me

Output Settings Tab Settings

Job Type

This section describes the settings in the Output Settings tab.

Xerox WorkCentre M128 PS | 2=l

General | [retails I Paper | Graphics I Fonts | PostSeript |
W atermarks I Configuration I Options Output Settings

—Jab Tupe

Job Type Marmal Print j

[Jzer 0

Hetreve Dacument Hame :

Bassword ; I
[oeumett Mame ; I

Start Prirt Tinne : 00 : oo 1

Output Size I Same as Paper Size

=
Banner Sheet : IUSB Printer Settings j
[~ E-mail Job Canfirmation

E-mail Addresz I

W Dizplay warning message about Output 5 ettings

[ Image Fatation (180deg)
Printer Status. .. |

About,.. | Help | Restore Defaults |

(u] 4 | Cancel | Apply |

NOTE: You can restore defaults by clicking [Restore Defaults].

You can specify the print function for Secure Print, Sample Print, and Delayed Print.

Secure Print temporarily stores print jobs in the printer, and then prints them when print
instructions are received from the control panel.

Sample Print outputs only one copy when multiple copies are specified. If there is no problem,
the remaining sets can be printed.

Delayed Print temporarily stores print jobs in the printer, and then prints them at the scheduled
time.

To use Secure Print, Sample Print, or Delayed Print feature, input the User ID and password for
Print Type in the Configuration tab. The password entered appears as asterisks(*).

Normal Print - Select when you do not want to output secure prints, sample prints, or delayed
prints.

Secure Print - Select when you want to output secure prints.
Sample Print - Select when you want to output sample prints.

NOTE: The Collated setting must be selected in the Page Setup tab when using Print
Type.

Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.

Xerox WorkCentre/WorkCentre Pro 123/128 Postscript® User Guide 15



2 Operation with Windows 95/98/Me

Settings

User ID - Displays the User ID for Job Type. The user ID displayed is the User ID specified on
the Configuration tab. This option can only be selected when the setting on the Configuration
tab has been completed. This is a display-only item and cannot be changed here.

Password - Displays password for Secure Print password specified in the Configuration tab.
Each digit that you enter appears as an asterisk (*). This option can only be selected when the
setting on the Configuration tab has been completed. This is a display-only item and cannot be
changed here.

Retrieve Document Name - Select the method of specifying the document name. If you have
selected Auto Retrieve, the valid document name can be up to 24 alphanumeric characters.

Document Name - When “Enter Document Name” is selected in the Retrieve Document Name
list, a document name up to 24 alphanumeric characters can be specified.

Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the cursor in
the hour or minute box and press the up or down triangle to specify the start time. You can also
set the time by entering the time directly into in the boxes. The default setting is 00:00.

Output Size - Selects the size of the paper used for output. The output is automatically enlarged
or reduced, depending on the paper size selected here and the paper size selected in the Paper
tab.

For example, when you select [B5] in Paper Size on the Paper tab, and select [A4] as the Output
Size, the output is automatically enlarged and printed.

When you select [None], the job is printed based on the Paper Size selected in the application.
Banner Sheet - Specifies whether or not to add a banner sheet to printed output.

When [Use Printer Settings] is selected, the printer settings are used.

When [Printer Start Page] is selected, outputs the banner sheet using the start-sheet.

E-mail Job Confirmation - Specifies whether or not to use the Mail Notify feature to notify the
end of the print job via e-mail. Default is [Off].

E-Mail Address - Specifies the e-mail address for the Mail Notify feature.

Display warning message about Output Settings - When printing, the printer driver checks
whether the Output Size setting conflicts with other settings.

When this is activated, a conflict dialog box appears if there is non-conformity during printing.
Check the content of the dialog box and resolve the conflicting function to continue printing.

When this is inactive, no conflict dialog box appears, but the conflicting setting is automatically
resolved and printing continues.

Image Rotation (180deg) - Set the checkbox to rotate the prints by 180°. Default is [Off].

How to Use Help

The following describes how to use Help.

1. Click | and a ? mark appears next to the pointer. You can then click items for
which you need explanations, opening a pop-up window that contains relevant
information. Click inside the pop-up window to close it.

2. Click [Help], an explanation of the current tab appears as Help information.

16
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3 Operation with Windows NT 4.0

The following information can be found in this chapter:
* About the Software
— Bundled Software
— Hardware/Software Requirements
* Installing the AdobePS Printer Driver
— Installation Procedure
e Device Options and Print Settings
— Device Settings Tab Settings

Configuration Tab Settings

Advanced Tab Settings
— Output Settings Tab Settings
* How to Use Help

About the Software

This section describes the software for Windows NT 4.0 that is included on the
Postscript Driver Library CD-ROM.

Bundled Software

The following items are included on the CD-ROM.

AdobePS Printer Driver (ver.5.2.2) and PPD files - Adobe Postscript driver and PPD
files (for Windows NT 4.0).

ATM (Adobe Type Manager)(ver. 4.0) - Helps you to install typefaces and activate
and manage your fonts.

Adobe Screen Fonts (TrueType/Postscript) - Includes 136 screen fonts (19
TrueType fonts and 117 Postscript fonts), which are compatible with the printer fonts.
ATM is used to install the Postscript screen fonts. When using these fonts to print, it is
recommended that you use the Adobe Postscript (5.2.2) printer driver.

Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing
platforms.
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3 Operation with Windows NT 4.0

Hardware/Software Requirements

The minimum system requirements for the Windows NT 4.0 printer driver are described
below.

Computer System

Personal computer in which the Windows NT 4.0 OS can operate.

Basic Software

Windows NT Workstation 4.0/Windows NT Server 4.0 (Service Pack 6a or later)

Installing the AdobePS Printer Driver

Install the AdobePS 5.2.2 printer driver onto Windows NT by following the procedure
below.

It is possible to cancel installation of the printer driver by clicking [Cancel] in the dialog
box displayed during installation. You can also click [Back] to delete the settings in that
dialog box and return to the previous dialog box.

Installation Procedure

1.

Start Windows NT 4.0.

NOTE: Log on as a Power User group member or an Administrator. Refer to the
Windows NT 4.0 documentation for details about the Power User group.

2.
3.
4,

On the Start menu, point to Settings and click [Printers].
In the Printer window, double-click [Add Printer].

Select how the printer is connected to the computer and click [Next]. Select [My
Computer] if the printer is connected directly to the computer or to the network in
the TCP/IP(LPD) environment. Select [Network printer server] in other cases. The
following is an example of a local printer.

NOTE: Specify the target printer in the Connect to Printer dialog box if you selected
[Network printer server].

5.

6.
7.
8

Select the port you are using and click [Next].
Insert the Postscript Driver Library CD-ROM in the CD-ROM drive.
Click [Have Disk].

Enter “Drive Name:\English\PrinterDriver\NT40” in the “Copy manufacturer’s files
from:” box and click [OK].

In this guide, we have used “E:” as the CD-ROM drive. If you are using a different
drive for the CD-ROM, specify accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM.

18
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3 Operation with Windows NT 4.0

9. Select your printer model from the Printers list and click [Next].

10. Enter the printer name, specify if you want to use the printer as the default printer,
and click [Next].

11. Select [Not shared] and click [Next].

We recommend that you install the driver on each computer with the procedure
appropriate to the Operating System.

12. Specify whether or not to print a test page, then click [Finish].
Installation begins.
13. Read the End User License Agreement and click [Agree].

When you click [Disagree], see If you click Disagree in the License Agreement on
page 19 for details.

14. Confirm that the printer has been added in the Printers window.

This completes installation of the printer driver. Remove the CD-ROM from the drive.
See Device Options and Print Settings on page 20 to configure the printer.

Store your CD-ROM in a safe place.

If you click Disagree in the License Agreement
Click [No] to return to step 13 and continue the operation.

Click [Yes] to cancel the installation. A printer is added in the Printers window, but the
printer driver is not installed properly.

Select the printer and click [Properties] on the File menu. The Re-installation tab is
added to the printer driver properties dialog box. Follow the directions on that tab.

When you finish reinstalling, see Device Options and Print Settings on page 20 to set
up the printer.
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3 Operation with Windows NT 4.0

Device Options and Print Settings

This section describes printer specific settings for printer driver properties and
document presets.

» Installable Options in the Device Settings Tab

» Configuration Tab

* Printer Specific Sections in the Device Settings of the Advanced Tab

* Output Settings Tab

NOTE: You can also refer to Help for explanations of these settings. See How to Use
Help on page 27.

To view the Device Settings or Configuration tabs, select the printer icon in the Printers
window, then click Properties on the File menu.

To view the Advanced or Output Settings tabs, select the printer icon in the Printers
window, then click Document Defaults on the File menu.

Device Settings Tab Settings

This describes Installable Options in the Device Settings tab. To print correctly, it is
necessary to make appropriate settings in this tab.

Select the items in Installable Options and change the settings in the Change Setting
box at the bottom of the tab.

@ Xerox WorkCentre M128 PS Properties 2| x| I
General I Ports | Scheduling I Sharing
Security Device Settings I Configuration
@ Job Timeout: <0 seconds» ;I

&i Wait Timeout: <300 seconds>

&i Mirimurn Font Size to Download as Dutline: <100 pivel(z)>

----- &*— Maximurm Font Size to Download as Bitmap: <600 pixel(s]>

EE Inztallable Options
. ff Memany: <Standard 2EEME>

- Hard Disk: <Mot &vailables

% Tray Options: <Mot Available:

% Finisher: <Mat fvailables

@ Regional Paper Setting: <AB Series>

— Change 'Memarny’ 5 etting

% Standard 256ME

512MB

k. Cancel HEls

20
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3 Operation with Windows NT 4.0

Settings

Memory - Specifies the amount of printer memory.

Hard Disk - Specifies whether or not the Hard Disk (optional) is installed. If it is, set to
[Available].

Tray Options - Specifies the paper tray type installed on the machine.
When [2-Tray Unit] is selected, Tray 3 and Tray 4 can be used.

When [2-Tray Unit (High Capacity)] is selected, Tray 3 and Tray 4 can be used as the
high capacity feeder.

Finisher - Specifies if the Finisher (optional) is installed. If it is, set to [Available].

Regional Paper Setting - Specifies the paper size group for different areas to enable
the selection of paper size common to that location.

Switch Paper Size (8K/16K) - Indicate your language preference to enable the set of
8K and 16K paper size that is best suited to your needs.

Configuration Tab Settings

Settings

This section describes the settings of the Configuration tab.

@ Xerox WorkCentre M128 PS Properties x| I
General | Parts I Scheduling | Sharing |
Security | Device Settings Configuration

Account Mode

Uger j

Detailed User Settings |

™ High Speed Printing

) Select High Speed Printing if print speed problems occurred
due to zpecific applications. Selecting this will restnct some
featurez, Uzually the check box iz not selected,

Get Infarmation franm Prinker | Fiestare Defaults |

Ok | Cancel | Help |

NOTE: You can restore defaults by clicking [Restore Defaults].

Account Mode - Specifies if all users or only System Administrators can change
authentication related settings.

Detailed User Settings - Sets the authentication information.
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Use Default User Settings - The values set in this feature are used as the
authentication parameters.

— Specify Job Owner Name - Select how to specify User ID.
— Job Owner Name - Enter a User ID.

— Password - Enter a Password that matches the User ID.

— Account ID - Enter an Account ID.

— Billing ID - Enter a User ID for Charge Print.

— Password - Enter a Password that matches the Billing ID.

Prompt User for Settings - Select this feature to display the [Enter User Details]
dialog-box each time you start printing. The user is then required to enter
authentication information such as their User ID.

— Display Previous User Details - Check the box to store the user details entered
in the [Enter User Details] dialog-box, and display the details in the box as a
default next time.

— Hide User_ID(***) - Check the box to specify whether a user ID is to be displayed
or hidden when it is entered.

— Hide Account ID(***) - Check the box to specify whether an account ID is to be
displayed or hidden when it is entered.

High Speed Printing - Set this feature to make improvements in print speed, when
using an application that generates Postscript directly.

Get Information from Printer - Clicking [Get Information from Printer] when the
machine is used as a network printer verifies the printer option installation state using
the print port to which the printer is connected, and reflects this in the Hardware Options
setting.
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3 Operation with Windows NT 4.0

Advanced Tab Settings

This section describes the settings of Printer Features in the Advanced tab.

Select the items from Printer Features under Document Options of the Advanced tab
and change the settings in the Change Setting box at the bottom of the tab.

Q‘-' Xerox WorkCentre M128 PS Default

Page Setup  Advanced I Output Settings |

= x]|

-5, Prirter Features

% Dffzet Stacking: <Mones

-1 Stapling: <Mone>

% Print Mode: <Standard:
% Halftone: <Fine Dotss
% Image Enhancement: <O

% Output Destination: <Center Dutput Tray:
% Feed Separators from: <Mone:
% Print on Separators: <Blank Separatorsy

% Paper Type (Separatars): <Use Printer Settings»

% Bypass Feed Orientation: <Partraits

[ |

— Change 'Output Destination’ S etting

% ii;'g Center Output Trap

@ Finigher Tray

ok |

Cancel | Helm |

NOTE: The settings that can be selected vary depending on which options have been
installed. Change these settings only after confirming that the option settings are
complete. See Device Settings Tab Settings on page 20.

Xerox WorkCentre/WorkCentre Pro 123/128 Postscript® User Guide

23



3 Operation with Windows NT 4.0

Settings

Output Destination - Specifies the output destination.

NOTE: The items that can be selected vary according to whether the optional side tray
kit or finisher has been installed.

Offset Stacking - The position of individual jobs or sets of copies are shifted to either
side of the output tray to enable easy separation.

Feed Separators from - Specifies the paper tray that transparency dividers are to be
fed from. When [Auto] is selected, the tray set on the machine is used as the feed
destination.

Print on Separators - Specifies whether or not to print on the transparency dividers as
well as the transparency.

Paper Type (Separators) - Specifies a paper type for the transparency divider.

Stapling - Specifies whether or not to staple printed documents and the position of the
staple. You can staple 2 to 50 sheets of 80 g/m? or lighter paper.

NOTE: You cannot use staples in the following situations.
— When anything other than Finisher Tray is selected as the Output Destination in
the Advanced tab.
— When Job Offset is selected.

Bypass Feed Orientation - Specifies the paper orientation when printing from the
bypass tray. When feeding the short edge of the paper first, select [Landscape]. When
feeding the long edge of the paper, select [Portrait].

Print Mode - Specifies whether to give priority to the print speed or the image quality.
Halftone - Specifies the halftone settings for printing.

Select [Fine Dots] for the small size halftone dot commonly used in Postscript.

Select [Thick Dots] for coarser dots than the Fine Dots setting.

Select [Type 3] for the same halftone setting that is used in PCL.

Image Enhancement - Specifies whether or not to use the Image Enhancement
function. Selecting [On] smooths out boundaries when printing. This reduces jagged
edges by artificially increasing the resolution of the image. When printing a bitmapped
image composed of coarse halftone dots, smooth color gradation is impossible in
certain situations. In this case, select [Off].

Draft Mode - Specifies whether or not to reduce the amount of toner used when
printing drafts. When [On] is selected, the overall printed color becomes lighter. This is
best for printing documents when high print quality is not necessary.

Custom Paper Auto Orientation - Specifies whether or not to correct the orientation
of the custom paper.

24
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3 Operation with Windows NT 4.0

Substitute Tray - Specifies what action to take when the paper for the print size is not
loaded in the machine.

Use Printer Settings - Use the printer settings. The settings can be confirmed on
the control panel.

Display Message - Display paper supply messages on the control panel. Printing
is impossible until paper is supplied.

Use Nearest Size (Adjust to Fit) - Selects the nearest paper size and automatically
adjusts the image size as necessary.

Use Nearest Size (No Zoom) - Selects the nearest paper size and prints the same
size as the image.

Use Larger Size (Adjust to Fit) - Selects paper larger than the original and
automatically adjusts the image size as necessary.

Use Larger Size (No Zoom) - Selects paper larger than the original and prints the
same size as the image.

Feed from Bypass Tray - Feed from bypass tray.

Print Mixed Size Originals - Controls the orientation of the second-side image when
printing double-sided.

Output Settings Tab Settings

This section describes the settings in the Output Settings tab.

&% Xerox WorkCentre M128 PS5 Default I

Page Setupl &dvanced  Output Settings I

—Jaob Type
Job Type : I Mormal Print j
1z | |
Eassnrd: |
Fietieye Mosument b ame IAuto Retrieve j
DEcumert Hame I
Shart it T Wﬂ

Banner Shest : IUse Printer Settings j

[ E-mail Job Canfirmation
E-mailfddiess; |

™ Image Rotation [180deq)

Printer Status... | Abaout... | Fiestare Defaults |

Ok | Cancel | Help |

NOTE: You can restore defaults by clicking [Restore Defaults].
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Job Type

You can specify the print function for Secure Print, Sample Print, and Delayed Print.

Secure Print temporarily stores print jobs in the printer, and then prints them when print
instructions are received from the control panel.

Sample Print outputs only one copy when multiple copies are specified. If there is no
problem, the remaining sets can be printed.

Delayed Print temporarily stores print jobs in the printer, and then prints them at the
scheduled time.

To use Secure Print, Sample Print, or Delayed Print feature, input the User ID and
password for Print Type in the Configuration tab. The password entered appears as
asterisks(*).

Normal Print - Select when you do not want to output secure prints, sample prints, or
delayed prints.

Secure Print - Select when you want to output secure prints.
Sample Print - Select when you want to output sample prints.

NOTE: The Collated setting must be selected in the Page Setup tab when using Print
Type.

Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.

User ID - Displays the User ID for Job Type. The user ID displayed is the User ID
specified on the Configuration tab. This option can only be selected when the setting
on the Configuration tab has been completed. This is a display-only item and cannot
be changed here.

Password - Displays the password for Secure Print as specified in the Configuration
tab. Each digit entered appears as an asterisk (*). This option can only be selected
when the setting on the Configuration tab has been completed. This is a display-only
item and cannot be changed here.

Retrieve Document Name - Select the method for specifying the document name. If
you have selected Auto Retrieve, the valid document name can be up to 24
alphanumeric characters.

Document Name - When “Enter Document Name” is selected in the Retrieve
Document Name list, a document name up to 24 alphanumeric characters can be
specified.

Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the
cursor in the hour or minute box and press the up or down triangle to specify the start
time. You can also set the time by entering the time directly into in the boxes. The
default setting is 00:00.
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3 Operation with Windows NT 4.0

Settings
Banner Sheet - Specifies whether or not to add a banner sheet to the printed output.
When [Use Printer Settings] is selected, the printer settings are used.
When [Printer Start Page] is selected, outputs the banner sheet using the start-sheet.

E-mail Job Confirmation - Specifies whether or not to use the Mail Notify feature to
notify the end of the print job via e-mail. Default is [Off].

E-Mail Address - Specifies the e-mail address for the Mail Notify feature.

Image Rotation (180deg) - Set the checkbox to [On] to rotate the prints by 180°.
Default is [Off].

How to Use Help

The following describes how to use Help.

1. Click ®] and a ? mark appears next to the pointer. You can then click items for
which you need explanations, opening a pop-up window that contains relevant
information. Click inside the pop-up window to close it.

2. Click [Help], an explanation of the current tab appears as Help information.
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4 Operation with Windows 2000,
Windows XP and Windows Server 2003

The following information can be found in this chapter:
¢ About the Software
— Bundled Software
— Hardware/Software Requirements
¢ Installing the Printer Driver
— Installation Procedure
« Device Options and Print Settings
— Device Settings Tab Settings

Configuration Tab Settings

Advanced Options Dialog Box Settings
— Output Settings Tab Settings
¢ How to Use Help

About the Software

This section describes the software for Windows 2000, Windows XP and Windows
Server 2003 included with the Postscript Driver Library CD-ROM.

Bundled Software

The following items are included on the CD-ROM and are necessary when using the
printer on Windows 2000, Windows XP and Windows Server 2003.

Microsoft PScript 5 Driver and PPD files - Microsoft PScript 5 Driver and PPD files
(for Windows 2000, Windows XP and Windows Server 2003).

Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing
platforms.
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Hardware/Software Requirements

The minimum system requirements for the Windows 2000, Windows XP and Windows
Server 2003 printer driver are described below.

Computer System

Personal computer in which the Windows 2000/Windows XP/Windows Server 2003 OS
can operate.

Basic Software

Windows 2000 Professional
Windows 2000 Server

Windows 2000 Advanced Server
Windows XP Professional Edition
Windows XP Home Edition
Windows Server 2003

Installing the Printer Driver

Install MS PScript 5 printer driver onto Windows 2000, Windows XP and Windows
Server 2003 by following the procedure below.

This section described how to install the printer driver for Windows 2000, as an
example.

NOTE: It is possible to cancel installation of the printer driver by clicking [Cancel] in
the dialog box displayed during installation. You can also click [Back] to delete the
settings in that dialog box and return to the previous dialog box.

NOTE: If you want to set up Port 9100, refer to the System Administration Guide.
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4 Operation with Windows 2000, Windows XP and Windows Server 2003

Installation Procedure

1. Start Windows 2000.

NOTE: Log on as a Power User group member or an Administrator. Refer to the
Windows 2000 documentation for details about the Power User group.

2. On the Start menu, point to Settings and click [Printers].

3. In the Printers window, double-click [Add Printer].

4. Click [Next].
5

Select how the printer is connected to the computer and click [Next].

Select [Local printer] if the printer is connected directly to the computer or to the
network in the TCP/IP(LPD) environment. Otherwise, select [Network printer]. The
following is an example of a Local printer.

NOTE: When you select [Local printer], deselect the “Automatically detect and install
my Plug and Play printer” check box.

NOTE: Specify the target printer in the Connect to printer dialog box if you selected
[Network printer].
6. Select the port you are using and click [Next].
When the printer is connected in the TCP/IP(LPD) environment:
1) Click [Create a new port].
2) Select Standard TCP/IP Port in the Type list and click [Next].
3) Click [Next].

4) Enter the IP address of the printer in Printer Name or IP Address, then click
[Next].

Click [Finish] in the dialog box that will be displayed.
Insert the Postscript Driver Library CD-ROM in the CD-ROM drive.
8. Click [Have Disk].

9. Enter “Drive Name:\English\PrinterDriver\win2000” in the “Copy manufacturer’s
files from:” box and click [OK].
In this guide, we have used “E:” as the CD-ROM drive. If you are using a different
drive for the CD-ROM, specify accordingly.

NOTE: Click [Browse] to specify a folder on the CD-ROM.

10. Select your printer model from the Printers list and click [Next].

11. Enter the printer name, set whether you want to use it as the default printer, and
click [Next].

12. Select [Do not share this printer] and click [Next].

We recommend that you install the driver on each computer with the procedure
appropriate to the Operating System.

13. Specify whether or not to print a test page, then click [Next].
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14. After confirming the settings displayed, click [Finish].
NOTE: If the dialog box “Digital Signature Not Found” appears, click [Yes] to continue
the installation.
Installation begins.
15. Confirm that the printer has been added in the Printers window.

This completes the installation of the printer driver. Remove the CD-ROM from the
drive.

See Device Options and Print Settings on page 32 to configure the printer.
Store your CD-ROM in a safe place.

Device Options and Print Settings

This section describes printer specific settings for printer driver properties. For other
items, refer to the Help.

« Installable Options in the Device Settings Tab

« Configuration Tab

» Printer Specific Sections in Printer Features of the Advanced Options Dialog Box
» Output Settings Tab

NOTE: You can also refer to Help for explanations of these settings. See How to Use
Help on page 39.

To view the Device Settings or Configuration tabs, select the printer in the Printers
window, then click [Properties] on the File menu.

To view the Advanced Options dialog box, select the printer in the Printers window,
then click [Printing Preferences] on the File menu. Click [Advanced] in the Layout
screen.

To view the Output Settings tab, select the printer in the Printers window, then click
[Printing Preferences] on the File menu.
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Device Settings Tab Settings

Settings

This section describes Installable Options in the Device Settings tab. To print correctly,
it is necessary to make the appropriate settings in this tab.

Select the items in Installable Options and change the settings in the menu that
appears on the right.

2]

General Sharing | Portz I Advanced
Security Device Settings | Configuration

------------- Available PostScripk Memory: 15070 KB ;I
------------- Qutput Protocal: ASCIT
------------- Send CTRL-D Befaore Each Job: Ma
------------- Send CTRL-D After Each Job: Yes
------------- Convert Gray Text ko PostScript Gray: Mo
------------- Conwert Gray Graphics to PostScript Graw: Mo
------------- Add Euro Currency Symbaol to PostScript Fonts: Mo
............. Job Timeout: 0 seconds
------------- Waik Timeaout: 300 seconds
------------- Mirirnurn Fork Size ko Download as Qutline: 100 pivelis)
------------- Maximum Font Size to Download as Bitmap: 600 pixel(s)
151 Installable Options
< Memory: I Standard 256ME - I
- Hard Disk: Mot Available
- Tray Options: Mot Availabls

- Finisher: Mok dvailable

- Regional Paper Setting: AB Series
s Switch Paper Size (8K 16K): Simplified Chinese =

QK Cancel Apply Hel

Memory - Specifies the amount of printer memory.

Hard Disk - Specifies whether or not the Hard Disk (optional) is installed. If it is, set to
[Available].

Tray Options - Specifies the paper tray type installed on the machine.
When [2-Tray Unit] is selected, Tray 3 and Tray 4 can be used.

When [2-Tray Unit (High Capacity)] is selected, Tray 3 and Tray 4 can be used as the
high capacity feeder.

Finisher - Specifies if the Finisher (optional) is installed. If it is, set to [Available].

Paper Size Setting - Specifies the paper size group for different areas to enable the
selection of paper size common to that location.

Switch Paper Size (8K/16K) - Indicate your language preference to enable the set of
8K and 16K paper size that is best suited to your needs.
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Configuration Tab Settings

This section describes the settings of the Configuration tab.

Parts | Advanced

Configuration

Sharing
Device Settings

General I
Secuiity I

Account Mode :

=

IUser

Detailed User Settings |

[” High Speed Printing

Select High Speed Frinting if print epeed problems occured
due to specific applicationz. Selecting this will restrict zome
features. Usually the check box iz not selected.

@

Get Information from Printer | Restare Defaults I

2]

] | Cancel | Apply | Help

NOTE: You can restore defaults by clicking [Restore Defaults].

Settings

Account Mode - Specifies if all users or only System Administrators can change
authentication related settings.

Detailed User Settings - Sets the authentication information.

Use Default User Settings - The values set in this feature are used as the
authentication parameters.

Job Owner Name - Enter a User ID.

Password - Enter a Password that matches the User ID.
Account ID - Enter an Account ID.

Billing ID - Enter a User ID for Charge Print.

Specify Job Owner Name - Select how to specify User ID.

Password - Enter a Password that matches the Billing ID.

Prompt User for Settings - Select this feature to display the [Enter User Details]
dialog-box each time you start printing. The user is then required to enter
authentication information such as their User ID.

— Display Previous User Details - Check the box to store the user details entered
in the [Enter User Details] dialog-box, and display the details in the box as a

default next time.
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— Hide User_ID(***) - Check the box to specify whether an account ID is to be
displayed or hidden when it is entered.

— Hide Account ID(***) - Check the box to specify whether an account ID is to be
displayed or hidden when it is entered.

High Speed Printing - Set this feature to make improvements in print speed, when
using an application that generates Postscript directly.

Get Information from Printer - Clicking [Get Information from Printer] when the
machine is used as a network printer verifies the printer option installation state using
the print port to which the printer is connected, and reflects this in the Hardware Options
setting.

Advanced Options Dialog Box Settings

This section describes the settings of the Advanced Options dialog box displayed when
clicking Advanced in the Layout tab.

Select the items from Printer Features and change them on the menu displayed to the
right.

ﬁ" Xerox W ﬂﬂ

Layout | Paper/Quality | Output Settings

r— Orientation
@ Portrait
 Landzcape

" Rotated Landscape

— Prirt or Both Sides(Duplex] —
@ None

" Flip on Long Edge

" Flip on Short Edge

— Page Order il ﬂ
@ Front to Back .

" Back to Front Eﬁh Document Options ;I

------ Advanced Printing Features; Enabled
Fages Per Sheet: I 1 VI %’éa PostScript Options

(-4 Prinker Features
Advanced... | inati
............. Cukput Destination: | Center Oukput Tray ;I

. Offsek Stacking: Mone
------------- Feed Separatars from: None

------------- Print on Separators: Blank Separators

- Paper Type {Separatars): Use Printer Settings
- Stapling: Mone

QK. Cancel Apply | Help |

- Bypass Feed Origntation: Portrait
............. Print Mode: Standard
------------- Halftone: Fine Dots

- Image Enhancement: ©n

- Draft Mode: OFf

- iCustom Paper Auko Orientakion: Sn

------------- Substituke Tray: Use Printer Settings
------------- Print Mixed Size Originals: QFF =

Ok Cancel
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Settings

Output Destination - Specifies the output destination.

NOTE: The items that can be selected vary according to whether the optional side tray
kit or finisher has been installed.

Offset Stacking - The position of individual jobs or sets of copies are shifted to either
side of the output tray to enable easy separation.

Feed Separators from - Specifies the paper tray that transparency dividers are to be
fed from. When [Auto] is selected, the tray set on the machine is used as the feed
destination.

Print on Separators - Specifies whether or not to print on the transparency dividers as
well as the transparency.

Paper Type (Separators) - Specifies a paper type for the transparency divider.

Stapling - Specifies whether to staple printed documents and the position of the staple.
You can staple 2 to 50 sheets of 80 g/m? or lighter paper.

NOTE: You cannot use staples in the following situations.
— When anything other than Finisher Tray is selected as the Output Destination in
the Advanced tab.
— When Job Offset is selected.

Bypass Feed Orientation - Specifies the paper orientation when printing from the
bypass tray. When feeding the short edge of the paper first, select [Landscape]. When
feeding the long edge of the paper, select [Portrait].

Print Mode - Specifies whether to give priority to the print speed or the image quality.
Halftone - Specifies the halftone settings for printing.

Select [Fine Dots] for the small size halftone dot commonly used in Postscript.

Select [Thick Dots] for coarser dots than the Fine Dots setting.

Select [Type 3] for the same halftone setting that is used in PCL.

Image Enhancement - Specifies whether to use the Image Enhancement function.
Selecting [On] smooths out boundaries when printing. This reduces jagged edges by
artificially increasing the resolution of the image. When printing a bitmapped image
composed of coarse halftone dots, smooth color gradation is impossible in certain
situations. In this case, select [Off].

Draft Mode - Specifies whether or not to reduce the amount of toner used when
printing drafts. When [On] is selected, the overall printed color becomes lighter. This is
best for printing documents when high print quality is not necessary.

Custom Paper Auto Orientation - Specifies whether or not to correct the orientation
of the custom paper.

Substitute Tray - Specifies what action to take when the paper for the print size is not
loaded in the machine.

Use Printer Settings - Use the printer settings. The settings can be confirmed on
the control panel.
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Display Message - Display paper supply messages on the control panel. Printing
is impossible until paper is supplied.

Use Nearest Size (Adjust to Fit) - Selects the nearest paper size and automatically
adjusts the image size as necessary.

Use Nearest Size (No Zoom) - Selects the nearest paper size and prints the same
size as the image.

Use Larger Size (Adjust to Fit) - Selects paper larger than the original and
automatically adjusts the image size as necessary.

Use Larger Size (No Zoom) - Selects paper larger than the original and prints the
same size as the image.

Feed from Bypass Tray - Feed from bypass tray.

Print Mixed Size Originals - Controls the orientation of the second-side image when
printing double-sided.

Output Settings Tab Settings

This section describes the Output Settings tab.

&% Xerox Worl e

Layoutl Paper/Quality  Output Settings |

rJob Type
Job Type: I Mormal Print Vl
= |
Passmond |
Fetrieye Document Mame : IAuto Retieve j
ocument Mame : I
Start Frint Time : lﬁj

B anner Sheet : IUSE Frinter Settings j

™ E-mail Job Confirmation
E-mail ddress : |

™ Image Rotation [180deq)

Prirter Status. .. I About.. | Restore Defaults I

ak. | Cancel | Apply | Help |

NOTE: You can restore defaults by clicking [Restore Defaults].
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Job Type

You can specify the print function for Secure Print, Sample Print, and Delayed Print.

Secure Print temporarily stores print jobs in the printer, and then prints them when print
instructions are received from the control panel.

Sample Print outputs only one copy when multiple copies are specified. If there is no
problem, the remaining sets can be printed.

If there is no problem, the remaining sets are printed.

Delayed Print temporarily stores print jobs in the printer, and then prints them at the
scheduled time.

To use Secure Print, Sample Print, or Delayed Print feature, input the User ID and
password for Print Type in the Configuration tab. The password entered appears as
asterisks(*).

Normal Print - Select when you do not want to output secure prints, sample prints, or
delayed prints.

Secure Print - Select when you want to output secure prints.
Sample Print - Select when you want to output sample prints.

NOTE: The Collated setting must be selected in the Page Setup tab when using Print
Type.

Delayed Print - Select when you want to output delayed prints.
See the On-line Help for details on the operation of the printer.

User ID - Displays the User ID for Job Type. The user ID displayed is the User ID
specified on the Configuration tab. This option can only be selected when the setting
on the Configuration tab has been completed. This is a display-only item and cannot
be changed here.

Password - Displays the password for Secure Print as specified in the Configuration
tab. Each digit entered appears as an asterisk (*). This option can only be selected
when the setting on the Configuration tab has been completed. This is a display-only
item and cannot be changed here.

Retrieve Document Name - Select the method for specifying the document name. If
you have selected Auto Retrieve, the valid document name can be up to 24
alphanumeric characters can be specified.

Document Name - When “Enter Document Name” is selected in the Retrieve
Document Name list, a document name up to 24 alphanumeric characters.

Start Print Time - Specifies the time that a Delayed Print job will be printed. Place the
cursor in the hour or minute box and press the up or down triangle to specify the start
time. You can also set the time by entering the time directly into in the boxes. The
default setting is 00:00.
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Settings
Banner Sheet - Specifies whether or not to add a banner sheet to the printed output.
When [Use Printer Settings] is selected, the printer settings are used.
When [Printer Start Page] is selected, outputs the banner sheet using the start-sheet.

E-mail Job Confirmation - Specifies whether or not to use the Mail Notify feature to
notify the end of the print job via e-mail. Default is [Off].

E-Mail Address - Specifies the e-mail address for the Mail Notify feature.

Image Rotation (180deg) - Set the checkbox to [On] to rotate the prints by 180°.
Default is [Off].

How to Use Help

The following describes how to use Help.

1. Click ®] and a ? mark appears next to the pointer. You can then click items for
which you need explanations, opening a pop-up window that contains relevant
information. Click inside the pop-up window to close it.

2. Click [Help], an explanation of the current tab appears as Help information.
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5 Operation on Macintosh Computers

¢ About the Software
— Bundled Software
— Hardware/Software Requirements

 Installing the AdobePS Printer Driver

Installation Procedure (Mac OS 9.x or earlier)

Setting the Printer Driver (Mac OS 9.x or earlier)

Installation Procedure (Mac OS X)
Adding a Printer (Mac OS X)
e Options

— Printer Specific Options Settings
— Printer Driver Settings

« Installing the Screen Fonts

About the Software

This section describes the Macintosh software that is included on the Postscript Driver
Library CD-ROM.

NOTE: When using AppleTalk protocol to print from Macintosh, set the EtherTalk port
to Enable on the control panel.

Bundled Software

Insert the CD-ROM and double-click the WorkCentre-PS icon to display the Window.
The following items are contained in the folder:

AdobePS Printer Driver (ver. 8.7.0, and 8.8) and PPD files - Adobe Postscript driver
and PPD files (for Macintosh).

PPD Installer - The PPD file installer for Mac OS X, 10.2.

Adobe Screen Fonts - Contains 117 Postscript fonts and 19 TrueType fonts, which
are standard for Postscript 3 printers. In addition, 37 Postscript fonts for the Central
European (CE) character set are included.

ATM (Adobe Type Manager) (ver. 4.5.2) - Helps you to install typefaces and activate
and manage your fonts.

Adobe Acrobat Reader - Allows you to view and print PDF files on all major computing
platforms.
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Hardware/Software Requirements

The minimum system requirements for the Macintosh printer driver and the utility are
described below.

Computer System
* Macintosh

* Power Macintosh

Basic Software
e« For AdobePS 8.7 - Mac OS 8.5 and 8.5.1
* For AdobePS 8.8 - Mac OS 8.6 through 9.2.2

 For PPD Installer - Mac OS X 10.2

NOTE: When using Mac OS X, launch the Classic environment to run the
applications.
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Installing the AdobePS Printer Driver

This section describes how to install the Adobe printer driver and how to set the printer
driver for this machine. There are two steps to install the printer driver. Firstly, use the
installer enclosed on the CD-ROM to install the printer to the Macintosh. Then,
configure the printer driver according to the printer used.

Installation Procedure (Mac OS 9.x or earlier)

This section describes the procedures for installing the AdobePS printer driver.
As an example, here is the procedure to install AdobePS 8.8.

1. Insert the Postscript Driver Library CD-ROM in the CD-ROM drive.
The WorkCentre-PS icon appears on the desktop.
2. Double-click [WorkCentre-PS].

3. Double-click the [PrinterDriver] folder depending on your printer model, and then
the “AdobePS880” folder.

Double-click [AdobePS Installer 8.8].
5. When the Installer opens, click [Continue].

Read through the license agreement carefully and if you have no objections to it,
click [Accept].

Read the Read Me displayed, then click [Continue].

7. Confirm the Install Location and change it if necessary, then click [Install].
Installation begins.

8. When the dialog box showing installation has completed appears, click [Restart]

or [Quit].
This completes the installation.
Proceed to Setting the Printer Driver (Mac OS 9.x or earlier) on page 44 to continue.
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Setting the Printer Driver (Mac OS 9.x or earlier)

When you finish installing the AdobePS printer driver, set the Postscript Printer
Description (PPD) file for this machine to the printer driver.

The printer driver controls the functions of this machine based on the information in the
PPD file.

1. Make sure that the machine is on.

2. Check that the machine’s EtherTalk port is set to Enable.

You can check the EtherTalk settings in the System Settings List. See User Guide
for details about how to print the System Settings List.

3. Onthe Apple menu select [Chooser], then click [AdobePS].

4. Select your printer from the Select a Postscript Printer list box, which appears to
the right of the Chooser, then click [Setup].

O=———-———(hooser=————H

Select a PostScript Printer:

AdobePS #ppleShare

Lazerwriter

Getw.J

@ Active
() Inactive

D]

AppleTalk

7.6.2

This automatically searches for the printer and sets the PPD file.
If the search for the PPD file is not automatically performed:

(1) Click [Select PPD].

(2) Select your printer model in the list, then click [Select].

Select a PostScript™ Printer Description File:

[ G Printer Descriptions i] — E-S5YS

[[] Xerox WorkCentre M123 PS Eject
[} Xerox WorkCentre M128 PS

Il
(]
=]
=
(=]
e

]

(setect ]

Printer Model:
Xerox WorkCentre M128v3015.103 PS
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The PPD file for this machine is set.

“Xerox WorkCentre M128 P5”

@ Current Printer Description File (PPD) Selected:

[ AutoSetup | [ SelectPPD.. |

[ Printer Info ] [ Configure

Cancel

5. Click [Configure] to set the options.

See Options on page 49 for details about the options.

NOTE: You can change the print settings after you install the printer driver.

NOTE: To use the options, it is necessary to set Configure. Always set this according
to the configuration of your machine. Also, Installable Options will usually be set
automatically according to the bi-directional communications of this machine. You do

not have to change the settings.

“Xerox WorkCentre M128 P5*
Installable Options

Memory: [ Standard 256MB | |
Hard Disk: [ Not Available i]

@ Current Printer Description File (PPD) Selected:

Tray Options: [ Not Available

2

Finisher: | Not Available | $ |

Regional Paper Setting: [AB Series

Kl

Cancel ] H 0K

6. Click [OK]. Click [OK] once more in the screen displayed.

7. Close the Chooser.
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Installation Procedure (Mac OS X)

Install the Postscript Printer Description (PPD) file for the Mac OS X into the Mac OS
Xv10.2.x Macintosh.

This section describes how to install the PPD file on a Mac OS X v10.2.4, as an
example.

NOTE: The printer driver does not need to be installed on the Mac OS X. It uses the
Adobe Postscript driver that is provided with the Operating System.

Installation Procedure

1. Insert the Postscript Driver Library CD-ROM in the CD-ROM drive.
The WorkCentre-PS icon appears on the desktop.
Double-click [WorkCentre-PS].
The WorkCentre-PS window opens.
3. Open the [Mac OS X] folder.
The Mac OS X window opens.
4. Double-click [PPD Installer].
The installer starts and the Authenticate window opens.

N

5. Enter the Administrator’s user name and password, then click [OK].
The License screen opens.

6. Read through the license agreement carefully and if you have no objections to it,
click [Accept].

7. Confirm the Install Location and change it if necessary, then click [Install].
When the dialog box showing installation has completed appears, click [Quit].
This completes the installation.
Proceed to Adding a Printer (Mac OS X) on page 47 to continue.
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Adding a Printer (Mac OS X)

Procedure

After the PPD file has been installed, set the PPD file for the printer driver, and then
add the printer.

The printer driver controls the printer functions based on the information in the PPD file.
As an example, this section describes how to add a printer on a Mac OS X v10.2.4.

1. Make sure that the machine is on.

2. Check that the machine’s port is set to Enable.
— When using AppleTalk, set the EtherTalk port to Enable.
— When using IP Printing, set the LPD port to Enable.

You can check the EtherTalk and LPD settings in the System Settings List. See the
User Guide for details about how to print the “System Settings List.”

3. Start [Print Center].
NOTE: You can find Print Center in the Utilities folder in the Applications folder.

4. When the Printer List screen opens, click [Add].

5. Select the protocol used to connect the printer.
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When using Apple Talk

1. Select [Apple Talk] from the menu, and specify the zone for the printer being used.

. 0686 Printer List — -
" AppleTalk )
! Local AppleTalk Zone s ]

| Name &l Type
PostScript printer @

[ Character Set'Western -|

Printer Model:  Auto Select

Cancel Add
\—anee”

2. Select the printer you are using from the list.
3. Select [Auto Select] from Printer Model.
4. Click [Add].

When using IP Printing

1. Select [IP Printing] from the menu, and enter the IP address for the printer being
used in Printer’s Address.

. 68 Printer List = -

IP Printing & ]

Printer's Address

Internet address or DNS name

@Use default queue on server

Queue Name
Printer Model: | Xerox )
| Model Name -
Xerox Phaser 8200DX
Xerox Phaser 8200N m
Xerox WorkCentre M123 v3015.103 PS i
Xerox WorkCentre M128 v3015.103 PS v

s S Ad
. Cancel | Add

2. Select [Xerox] from Printer Model, and select the printer to be used.
3. Click [Add].
This completes the addition of a printer.

Printer options
Click [Printers] on the Print Center menu bar, and select Show Info.

Next, select [Installable Options], and select the options that have been installed on the
printer. See Options on page 49 for details about the options.
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Options

This section describes the Configure in the Chooser and the Printer Specific Options of
the printer driver.

Printer Specific Options Settings

For Mac OS 9.x and eatrlier

This section describes Installable Options for operating systems earlier than Mac OS
9.x.

NOTE: Usually, Installable Options are automatically set according to the bidirectional
communications of this machine. You do not have to change the settings.
1. Select the printer using the Chooser and click [Setup].
The Current Printer Description File (PPD) Selected dialog box appears.
2. Click [Configure].

@ Current Printer Description File (PPD) Selected:
“Xerox WorkCentre M128 P5”

[ AutoSetup | [ SelectPPD.. |

[ Printerlnfo] [ Configure ]

The Installable Options list appears.

3. Set the option menu items in Installable Options, and click [OK].

@ Current Printer Description File (PPD) Selected:
“Xerox WorkCentre M128 P5*
Installable Options
E
Memory: [ Standard 256MB | 3 |
Hard Disk: | Not Available | 3]
Tray Options: [ Not Available i]
Finisher: [ NotAvailable | 4]
Regional Paper Setting: [AB Series i] E
Cancel ] H 0K ]l
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For Mac OS X

Settings

This section describes Installable Options for Mac OS X.

1. Click [Printers] on the Print Center menu bar, and select [Show Info].

2. Select [Installable Options], and select the options that have been installed on the
printer.

Printer Info

Installable Options it}

Memory:  Standard 256MEB ?
| Hard Disk

Tray Options:  Not Available ?
| Finisher

Regional Paper Setting: ~ AB Series T‘

Switch Paper Size (8K/16K): Simplified Chinese T‘

( Apply Changes y

Memory - Specifies the amount of printer memory.

Hard Disk - Specifies whether or not the Hard Disk (optional) is installed. When the
Hard Disk is installed on the machine, set to Available.

Tray Options - Sets the tray installed on the machine.
When [2-Tray Unit] is selected, Tray 3 and Tray 4 can be used.

When [2-Tray Unit (High Capacity)] is selected, Tray 3 and Tray 4 can be used as the
high capacity feeder.

NOTE: This item is displayed in Mac OS X only.
Finisher - Sets whether or not the Finisher is installed. When the Finisher is installed
on the machine, set to [Available].

Paper Size Setting - Specifies the paper size group for different areas to enable the
selection of paper size common to that location.

Switch Paper Size (8K/16K) - Indicate your language preference to enable the set of
8K and 16K paper size that is best suited to your needs.
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Printer Driver Settings

This section describes Printer Specific Options, used to set the printer driver.

1. On the File menu of the application, click [Print].
The Print dialog box appears.
2. Select [Printer Specific Options].

2.8.0 (3017

Printer: [ i] Destination:

v General
Adobe Photoshop® 5.0
Background Printing [ Reverse Order
Cover Page
Color Matching

Layout .
To:
Ervor tlandling [ e[ ]

PostScript Settings

Printer Specific Options SR [Autu BEIECT L]
(4 Hirstpage from: | Auto Select (Paper Type)

Remaining from: | Auto Select (Paper Type)

Al [cancer ) [“print

Adobe

3. Specify the functions that you want to set.

8.0 (3017

Printer: [ i] Destination:

[ Printer Specific Optio... i]

Output Destination: [ Center Output Tray i]

Offset Stacking: | None v I
Collated:

Feed Separators from: [ None i]

Print on Separators: [ Blank Separators i]

Paper Type (Separators): [ Use Printer Settings i]
Stapling: [ None i]

Bypass Feed Orientation: | Portrait > I

L[]

Al
Save Settings A [ cancel | |[ Print |
hdobe

Settings
This section describes the settings in the Printer Specific Options list.

The settings that can be selected vary depending on which options have been installed.
Make these settings after specifying the installed options in Configure. See Printer
Specific Options Settings on page 49.

Output Destination - Specifies the output destination.

NOTE: The items that can be selected vary according to whether the optional side tray
kit or finisher has been installed.
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Offset Stacking - The position of individual jobs or sets of copies are shifted to either
side of the output tray to enable easy separation.

Collated - Selects whether to collate a multiple-page file per set when they are printed.
This function is enabled when the printer HDD kit is installed.

Feed Separators from - Specifies the paper tray that transparency dividers are to be
fed from. When [Auto] is selected, the tray set on the machine is used as the feed
destination.

Print on Separators - Specifies whether or not to print on the transparency dividers as
well as the transparency.

Paper Type (Separators) - Specifies a paper type for the transparency divider.

Stapling - Specifies whether to staple printed documents and the position of the staple.
You can staple 2 to 50 sheets of 80 g/m? or lighter paper.

NOTE: You cannot use staples in the following situations.
— When anything other than Finisher Tray is selected for Output Destination in the
Advanced tab.
— When Job Offset is selected.

Bypass Feed Orientation - Specifies the paper orientation when printing from the
bypass tray. When feeding the short edge of the paper first, select [Landscape]. When
feeding the long edge of the paper, select [Portrait].

Paper Type (Bypass Tray) - Specifies a paper type for the transparency divider.
Print Mode - Specifies whether to give priority to the print speed or the image quality.
Halftone - Specifies the halftone settings for printing.

Select [Fine Dots] for the small size halftone dot commonly used in Postscript.

Select [Thick Dots] for coarser dots than the Fine Dots setting.

Select [Type 3] for the same halftone setting that is used in PCL.

Image Enhancement - Specifies whether or not to use the Image Enhancement
function. Selecting [On] smooths out boundaries when printing. This reduces jagged
edges by artificially increasing the resolution of the image. When printing a bitmapped
image composed of coarse halftone dots, smooth color gradation is impossible in
certain situations. In this case, select [Off].

Draft Mode - Specifies whether or not to reduce the amount of toner used when printing
drafts. When [On] is selected, the overall printed color becomes lighter. This is best for
printing documents when high print quality is not necessary.

Custom Paper Auto Orientation - Specifies whether or not to correct the orientation
of the custom paper.

Substitute Tray - Specifies what action to take when the paper for the print size is not
loaded in the machine.

Use Printer Settings - Use the printer settings. The settings can be confirmed on
the control panel.

Display Message - Display paper supply messages on the control panel. Printing
is impossible until paper is supplied.
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Use Nearest Size (Adjust to Fit) - Selects the nearest paper size and automatically
adjusts the image size as necessary.

Use Nearest Size (No Zoom) - Selects the nearest paper size and prints the same
size as the image.

Use Larger Size (Adjust to Fit) - Selects paper larger than the original and
automatically adjusts the image size as necessary.

Use Larger Size (No Zoom) - Selects paper larger than the original and prints the
same size as the image.

Print Mixed Size Originals - Controls the orientation of the second-side image when
printing double-sided.

Installing the Screen Fonts

This section explains how to install the fonts in the Screen Font folder.

It is recommended that all other applications are closed before installing the fonts.
Otherwise, a warning message appears between steps 5 and 6.

1.

Start Macintosh and insert the Postscript Driver Library CD-ROM into the CD-
ROM drive.

Double-click the [WorkCentre-PS] icon followed by the Screen Font folder and
then the [PS3 Fonts Installer]. The following window appears:

When the Installer window appears, click [Continue].
The license agreement dialog appears.

4. Read through the agreement carefully and if you have no objections to it, click

5.

[Accept].
The PS3Fontsinstaller dialog box appears.
You may select [Easy Install] or [Custom Install].
Easy Install - installs all the fonts provided in the Screen Font folder.
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Custom Install - installs the selected fonts only. Simply click on the triangle arrow
beside the four categories of fonts to display the fonts in each category and then
check the fonts to be installed. For example, the diagram below shows that Arial CE
of the CE TrueType fonts is selected.

PS3Fontsinstaller —"r———"r——=H

Custom Install

- O] PostScript Type 1
- O TrueType
I O CEType 1
— [E CETrue Type
[ Arial CE
[0 Times New Roman CE

CoECUuE

D]

Disk space available: 2,097,018 Approximate disk space needed: 1, 530K
— Install Location _
Quit I
on the disk "Mac0S9E | Install |

i

A warning message will appear if you did not quit all other applications before
performing the font installation.

6. Click [Install].

The installation of the fonts begins.
After the installation, you have to restart your Macintosh before the fonts can be used.
Store your CD-ROM in a safe place.
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6 Appendix

Cautions and Limitations

Troubleshooting

See the User Guide for error codes and error messages displayed on the control panel.
See the User Guide for how to deal with paper jams.

Print operation

The printer driver allows you to make selections to print on custom paper and postcards
using duplex and/or the stapling feature to the Finisher Tray. However, these features
cannot be used when printing on custom paper or postcards.

You can feed custom paper from the bypass tray only. However, when you select
custom paper, the Paper Source selection does not change to Manual Feed
automatically. Please select Manual Feed yourself.
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